Basic Computer Skills
Module 3

Introduction to
Microsoft Word 2010
# Basic Computer Skills Module 3

## Introduction to Microsoft Word 2010

### Summary

<table>
<thead>
<tr>
<th>Goal:</th>
<th>Instructor:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Students will plan, create, and modify several documents using word processing features learned in this unit.</td>
<td><em>Computer Skills Instructor</em></td>
</tr>
</tbody>
</table>

SMART Objectives: *Specific, Measurable, Achievable, Realistic, and Time-sensitive*

By the end of this module, students should be able to:

- **BCS 3.1**: Understand the features of Microsoft Word 2010.
- **BCS 3.2**: Use a template to create a business cover letter and a resume.
- **BCS 3.3**: Use the mail merge feature in Microsoft Word 2010 to create mailing labels.

<table>
<thead>
<tr>
<th>Delivery Method(s):</th>
<th>Length:</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Lecture</em></td>
<td><em>Three Topics</em></td>
</tr>
<tr>
<td><em>Independent Study</em></td>
<td><em>Total length of 5-6 hours</em></td>
</tr>
<tr>
<td><em>Group Work</em></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Any Applicable Business and/or Soft Skills?</th>
<th>Corresponding NLS Lesson #?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Take Away Message(s):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word 2010 has many features that will help to simplify the production of documents and make documents look visually appealing. This is especially helpful when working with documents that you will encounter in business environments.</td>
</tr>
</tbody>
</table>

Basic Computer Skills Module 3-1
Title of Module: Introduction to Microsoft Word 2010

Instructor:

The intent of this module is to provide the students with a basic understanding of the Microsoft Word 2010 software.

The following are potential introductory remarks as well as relevant context or background information that may be useful for the instructor.

Technology is ever evolving. Thus, certain topics/information in this module may change or become obsolete during the course of instruction. It is a good idea for the instructor to review all content for accuracy and relevance, and to be prepared to present updated information if necessary.

Agenda – topics to be covered in the module and length of each item

<table>
<thead>
<tr>
<th>Topic: Microsoft Word</th>
<th>Time Allotted: 5-6 hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Word Processing Fundamentals</td>
<td>(2-3 hours)</td>
</tr>
<tr>
<td>B. Using a Template to Create a Cover Letter and Resume</td>
<td>(1-2 hours)</td>
</tr>
<tr>
<td>C. Creating Mailing Labels and Using Mail Merge</td>
<td>(1 hour)</td>
</tr>
</tbody>
</table>

Materials & Supplies – items needed in order to carry out the agenda and classroom activities


2. Computers loaded with MS Office 2010, connected to a printer

3. A telephone book, or pre-printed directory or companies/agencies that use braille transcription services, with contact information

4. Resources on writing a business letter
5. Samples of resumes in a variety of styles
7. MS Word PowerPoint and Matching Handout for Participants (3.A.1)

Classroom Preparation – steps to follow when setting up the learning environment

1. Whenever possible, it is a good idea to create samples of each product to have ready for students to view and to anticipate any issues or concerns that may arise during instruction.
2. Decide on a location – either on the computer or in a folder – where students can store their work samples.
3. Have all handouts printed and a screen/projector set up for accompanying PowerPoint presentation.
A. Word Processing Fundamentals (2-3 hours)

Objective BCS 3.1: Understand the features of Microsoft Word 2010.

**PREINSTRUCTIONAL ACTIVITIES**

Discuss the objectives for this module. Lead students in a discussion of the Microsoft Office Suite and its applications, particularly Word, Excel, and PowerPoint. Discuss features of past Microsoft Word and Works applications to help assess prior knowledge.

**CONTENT PRESENTATION AND LEARNER PARTICIPATION**

Ensure that each student is seated at a computer loaded with Microsoft Word 2010. Distribute copies of the **Microsoft Word 2010 Screenshot (3.A.3)** handouts and show the **Introduction to Microsoft Word 2010 video (3.A.2)**. During the video, pause and point out certain features as they are being presented in the video. If possible, allow students to replicate the items being demonstrated in Microsoft Word on their own computers.

While watching the video, also allow students time to label and take notes on the **Word 2010 Screenshot (3.A.3)** handouts. Explain to students that they can use these sheets as notes to reference on upcoming Microsoft Word 2010 activities.

Present and discuss each slide in the accompanying **MS Word Powerpoint (3.A.1)** for this module, and allow students to ask questions and take notes on the matching handouts.

B. Using a Template to Create a Cover Letter and Resume (1-2 hours)

Objective BCS 3.1: Use word processing and/or desktop publishing software to create a business letter.

**PREINSTRUCTIONAL ACTIVITIES**

Discuss with students some of the opportunities that they may be aware of relating to braille transcription, and ask them what plans they have for their certification in the future. Ask questions about how they will go about finding leads for braille transcription opportunities. You can also discuss the process of beginning a small business. Don’t worry about going into too much detail – this topic will be revisited again in a later module. This discussion will lead directly into the next activity.
**CONTENT PRESENTATION AND LEARNER PARTICIPATION**

Explain to students that in a business environment, an effective business document clearly and concisely conveys its message and has a professional, organized appearance. Inform them that while some people prefer to use their own creativity in creating original documents, others use *templates* to assist with completing the task. Help them understand the need to fill in or replace prewritten words in a template.

Tell students that they will be completing a series of activities that directly relate to their futures as braille transcribers and that they can use these documents to assist them in establishing their careers as braille transcribers.

Discuss the purpose of a cover letter with them, and then explain that they will be creating a sample cover letter for their future business. Tell students that they should always send a personalized cover letter with a resume which highlights aspects of their background relevant to the position for which they are applying.

Guide students in creating an effective cover letter by addressing these points:

- A finished business letter should look like a symmetrically framed picture with evenly spaced margins, all balanced below an attractive letterhead.
- A well-written, properly formatted cover letter presents solid evidence of your writing skills and provides insight into your personality.
- The content of a letter should contain proper grammar, correct spelling, logically constructed sentences, flowing paragraphs, and sound ideas.
- Be sure to proofread carefully. Reading from bottom to top or right to left can assist in catching more common errors.

**Activity**

Distribute copies of the *Using a Business Letter Template (3.B.1)* handout, then allow students to sit at a computer loaded with Microsoft 2010. Discuss the various letter options, pointing out differences between those with letterheads and those without. Assist them in working through the directions, providing feedback as they include and/or modify using all of the following suggested essential elements of a cover letter:

- The *date line* – the month, day, and year, positioned two to six lines below the top of the page or letterhead (if applicable).
- The *inside address* – positioned three to eight lines below the date line; usually contains the addressee’s full name and title, business affiliation, and full address.
The **salutation** – positioned two lines below the last line of the inside address. If you do not know the addressee’s name, use their title in the salutation – i.e. Dear Hiring Manager.

- The body of the letter or **message** – positioned two lines below the salutation. Paragraphs are single spaced with one blank line between paragraphs.
- The **complimentary close** – this should be positioned two lines below the last line of the message. Capitalize only the first word in the complimentary close.
- The **signature block** – at least four lines below the complimentary close, with enough room for the author to sign their name.

Have them save a copy into a folder or on the computer in an area that you have designated to house their work samples.

**Activity**

Lead students in a discussion of what a resume is and the kinds of content that should appear on a resume. Share several samples with the participants as points of reference if available. Assist students in brainstorming information that they could place in a resume such as:

- Contact information (complete legal name, mailing address with phone number and email address, if applicable.)
- Prior work experience
- Volunteer experience
- Educational background
- Certifications (Be sure to include braille certification to be earned at the end of the curriculum)
- Organizations
- Recognitions and awards
- Skills
- References

Share the e-How article **How to Write a Resume (3.B.2)** to further help with generating ideas.

Distribute copies of the **Using a Resume Template (3.B.3)** handout, then allow students to sit at a computer loaded with Microsoft 2010. Review the purpose of resume with them, and then explain that they will be creating a sample resume for their future business.
Assist students in working through the directions, and have them save a copy into a folder or on the computer in an area that you have designated to house their work samples.

Remind students that they will revisit and edit both their resume and cover letter in Module 15 of the Soft Skills Track – Career Planning and Portfolio Development.

C. Creating Mailing Labels and Using Mail Merge (1 hour)

Objective BCS 3.1: Use Microsoft Word 2010 to address envelopes and mailing labels.

**PREINSTRUCTIONAL ACTIVITIES**

Explain to students that Word 2010 allows them to print address information on an envelope or on a mailing label, which look more professional than handwritten ones.

**CONTENT PRESENTATION AND LEARNER PARTICIPATION**

Use the **Braille Contracting Prospects Project – Getting Started (3.C.1)** and phone books to assist students in locating up to 10 potential clients/companies. Alternatively, you may supply students with a list that you have created specifically for this lesson. Have students enter the information into the table that they create for this exercise.

When they are finished, lead them in creating a template for mailing labels using the **Braille Prospective Clients Mail Merge Activity (3.C.2)**.
Basic Computer Skills
Module 3

Introduction to Microsoft 2010 Handouts
Microsoft Word 2010 Screenshot (3.A.3)
Creating Business Letter Template Directions (3.B.1)

1. Click the File tab.

2. Click New

3. Click Sample Templates from the icons located at the top center of the screen.
4. View the sample templates. Notice that there are templates for letters, reports, fax cover sheets, and other documents. Pay specific attention to the Letter samples. Click the one you like, then click Template and Create. (Tip: Selecting Template allows you to save the blank letterhead so you can use it to write other letters later.)

5. Replace the italicized the information in brackets with your information.
6. Follow your instructor’s guidelines to modify the document. Refer back to the Microsoft Word 2010 Screenshot (3.A.3) handouts or video as needed.
7. As it is complete, click on the File tab and choose Save as
8. Change the Save as Type to Word Template
9. Save to your files as Business Letter Template. You will use this template in later activities.

3.B.1
How to Write a Resume (3.B.2)

How to Create a Great Resume

By Penny Loretto, About.com Guide

An effective resume is one that gets results. The purpose of a resume is to obtain an interview and ultimately to get the job or internship. All the effort spent on writing a good resume is worth it and the tips below will help you write a resume that gets results.

Be selective in the information you share on a resume and include only the details that are relevant to the employer and the position. Be concise and succinct in all descriptions and avoid the use pronouns and articles (a, an, the) whenever possible. Take a look at this resume template for ideas on what to include on your resume.

**Difficulty:** Average

**Time Required:** 1 - 3 Hours

**Here's How:**

1. **Formatting for results.**

   The formatting of a resume is very important and provides the necessary information in a logical, easy to read sequence. The use of underlines, italics, bold, and all caps can guide the employer through the resume with ease. Consistency is key when developing a resume and helps make the information on the resume simple for employers to read.

2. **Start by including your personal information.**

   The employer wants to know your name, address, phone number, and email address on the top of the first page of your resume. Personal information such as marital status, age, religion, and political affiliation are not included on a resume and are illegal questions for employers to ask.

3. **Including an Objective or Summary of Qualifications is optional.**

   An objective (optional) can immediately help identify the position to which you are applying. A Summary of Qualifications (optional) can offer a list of your skills and accomplishments right at the very beginning of your resume. You can also include 3.B.2
why you are writing in the cover letter if the employer asks for one.

4. **Marketing yourself.**

   Be sure to first list the most relevant experiences related to the internship or job to which you are applying. You may entitle this section Relevant Experience, Business Experience, Leadership Experience, etc.

   Maintain consistency in your resume by presenting your information in a logical consistent format utilizing boldface, italics, and capital letters to emphasize headings and important pieces of information. Avoid using several different type sets within the resume.

5. **Use Action Verbs to describe your responsibilities & accomplishments.**

   Creating effective verb statements highlighting your skills and accomplishments will make your resume strong and create a favorable impression with employers. By including only relevant information with just enough detail to demonstrate your skills, you will be illustrating your attention to details along with your ability to communicate and organize your thoughts.

6. **Include all relevant Education, Honors, Degrees, & Certifications.**

   When applying for internships Education, Honors, and Awards will usually go at the beginning of the resume and will move to the end once you have developed some professional experience. As a student, Education will be the first major category (after Objective or Summary if you include one), since student is your most recent full-time role.

7. **Maintain white space.**

   Try to keep margins to 1” all around the edges of the resume and include some spacing within the resume to give it a fresh, professional look. You want to create a resume that’s easy to skim.

8. **Prepare several resumes.**

   Be prepared to change your resume based on the position in which you are applying. You may choose to change the information provided or you may just
change the order in which you present the information.

9. **Focus on the qualifications of the position and the needs of the employer.**

Each resume should be the result of researching the employer and reviewing the position description if possible. Be sure to include certifications, achievements, volunteer, internship, employment experiences as well as any special skills such as computer, foreign language, music, art, etc.

10. **Try to keep it to one page.**

For internships and entry level positions, one page is sufficient. One you have been in the workforce for ten years or more or if you have had extensive lab experiences or publications, two pages may be required. Be sure to put your name and page 2 at the top of the second page of the resume. Do not staple and avoid folding if possible. Use laser bond paper and you may select a matching #10 envelope or large 9" x 12" envelope.

11. **Review the overall format and how the resume appears visually.**

Once you have included all the information and have checked for consistency and formatting, take a good look at how the resume looks and if it is professional. The overall look and appeal of the resume will provide the employer with a lasting first impression of you as an applicant.

12. **Proofread.**

This is the time you will want to be a perfectionist. There is no room for grammatical and/or spelling errors in a resume. Set it down and come back to it, have someone critique it, do whatever is necessary to ensure that your document is absolutely perfect. You will not get a second chance to create a good impression if you send out a resume that includes errors.

13. **Congratulate yourself.**

Congratulations! You have prepared a resume you can be proud of. Every couple of years you will probably need to update the information on your resume; but the hard work is behind you.

**What You Need:**

3.B.2

Basic Computer Skills Module 3-14
• Resume Paper

• Matching or 9" x 12" Envelope

This About.com page has been optimized for print. To view this page in its original form, please visit: http://internships.about.com/od/resumetipssamples/ht/ResumeTips.htm ©2011 About.com, Inc., a part of The New York Times Company. All rights reserved.

Links in this article:

Using a Resume Template (3.B.3)

1. Click the File tab.

2. Click New

3. Click Sample Templates from the icons located at the top center of the screen.
4. View the sample Resume templates. Click the one you like, then click Template and Create. (Tip: Selecting Template allows you to save the blank letterhead so you can use it to write other letters later.)

5. Replace the text in brackets with your information.
6. Be sure to mention any past experience you have had, including your Braille Curriculum Training!
7. For more information on writing good resume, be sure to read the eHow article “How to Write a Resume.”
8. As it is complete, click on the File tab and Choose Save as.
9. Change the Save as Type to Word Template.
10. Save to your student files as Resume Template. You will use this template in later activities.
Braille Contracting Prospects Project – Getting Started Guide (3.C.1)

Congratulations! You have completed your Braille Transcribers Course and are now ready to begin contacting prospective clients. As part of your research, you will be collecting contact information for each client/company. You will need to create a Microsoft Word document named *Braille Contracting Prospects*. In that document, you will create a table and type the following information. This table will be used to merge with a letter and labels to send to prospective clients.

2. Press the Insert on the Toolbar to insert a table with 7 columns and 11 rows into the blank document. Label each column as shown below:

<table>
<thead>
<tr>
<th>Title</th>
<th>First Name</th>
<th>Last Name</th>
<th>Company Name</th>
<th>Address</th>
<th>City</th>
<th>ST</th>
<th>Zip</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. After typing the table, click anywhere on the table. Notice that two new tabs appear in your Toolbar – Design and Layout. These new tabs are highlighted by a yellow bar called Table Tools.

3.C.1
4. Click the Layout Tab and then click the Sort button. This will highlight the entire table in blue.

5. In the “My list has” section at the bottom left, make sure Header Row is selected. Then under Sort by, select Last Name. Be sure Ascending Order is selected. Word will adjust the contents of the entire table.

6. Save the document as *Braille Contracting Prospects* and close it for the merge steps.
Braille Prospective Clients Mail Merge Activity (3.C.2)

A. Mailing labels

1. First, you will create mailing labels to send a letter prospective clients:
   b. Choose the Mailings Tab
   c. Click Start Mail Merge button and select Labels...
   d. In the box called Label Options, change the Label vendors to Avery US Letter and choose Product Number 5160 Easy Peel Address Labels. Click OK.
e. If you do not see gridlines that shows each label’s boundaries in your document, clicking on the Layout Tab and selecting View Gridlines will cause them to appear.

f. Click anywhere on the page. Then, using the Table Selection handle (four-headed arrow in the upper, left-hand corner) select the entire table.

g. Click the Mailings Tab, then click the Select Recipients button.

h. Choose Use Existing List and select the *Braille Contracting Prospects* file

3.C.2
i. In the Write and Insert Fields sections on the Mailings tab, click the Insert Merge Field button. Select Database Fields and click on the following fields, pressing the Insert button after each choice. Click Close when done.

- «First_Name_»
- «Last_Name»
- «Address»
- «City», «ST» «Zip»

j. Once you have closed the Insert Merge Field box, you will need to add spaces, commas, and press Enter in the appropriate places to format the address properly.
k. Click the Update Labels button to place the field codes throughout the labels.

![Image of Microsoft Word labels]

l. Click the Preview Results button to view your labels. Each client’s label with address, etc. should fill the page of labels. If spaces, commas, line breaks are missing – click the Preview Results button to correct.

m. If directed by your instructor, print your results by choosing the Finish and Merge button on the Mailings Tab.

n. When all data is correctly placed in the labels, click Preview Results. Then save your file as Braille Contracting Labels.
B. Mail Merge

1. In Word, you will use the Business Letter Template you created to prepare the Mail Merge form letter.
   a. Click the File tab and Open.
   b. Find the name of the Business Letter Template you created and click Open.

2. On the Mailings Tab, click on Start Mail Merge and choose letters.

3. Click the Select Recipients button and choose Use Existing List and select the Braille Contracting Prospects file.

4. Scroll through the file – you should see a letter for each of the contacts in your list. Proofread, spell check, and save your letter to your student folder as Braille Contracting Prospects Letter.